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 Focus on you! 
                    Grow your business, grow your person
                                    &  success will follow!!
            Don’t worry about what everyone else is doing.                              	

				     Be accountable for you! 
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TWO WORDS THAT CAN SEND YOU INTO A TAILSPIN...

SALE$TAX
WITH KRISTIN KORPOS



L E G A L

b y  K r i s t i n  K o r p o s

“Sales tax for photographers.” Your first instinct might be to run for the hills, 
but sales tax is definitely something you need to understand as a business owner. During 
the past few years I have seen countless photographers ask about sales tax in online 
forums and groups. All too often the conversation includes at least one photographer 
having what I call an “oh crap” moment in which they say, “Huh, I had absolutely no 
idea I was supposed to collect sales tax!” Here is an example:

Amy spent four years building her wedding photography business and 
things were going great. Her booking percentage was high and she 
had worked hard to improve her album sales process, which helped to 
significantly increase her annual gross revenue to $150,000 in 2011. 
Then one day she received a letter from her state tax office informing 
her that her business was selected for a sales tax audit. During this 
audit, she discovered she should have collected sales tax from her clients 
on not only her album sales, but also on the photography services she 
provided. She had erroneously believed that her photography services 
were not subject to sales tax and now she owed the state over $25,000 in 
unpaid sales tax, plus fines and interest!

I don’t want you to be in Amy’s shoes. I don’t want you to be the photographer who fails 
to collect sales tax from your clients and finds out too many years down the road that the 
state is coming to audit you and wants its money. The tax money that you fail to collect 
comes straight out of your pocket. Sure, you can try and find your clients and ask them if 
they will pay the sales tax you mistakenly didn’t collect from them two years ago…good 
luck with that! They are under no obligation to pay it.

I want you to be the proactive photographer who ensures you are running your business 
legitimately! I want you to be the photographer who thinks about the health and future of 
your business and plans for long-term success!

In part one of this two-part series I will provide an introduction to sales and use tax, 
explain why services may be subject to sales tax, and address a big sales tax myth 
regarding the taxability of electronically delivered images.

©Kristin Korpos



Sales and Use Tax Overview

A sales tax is a transaction tax that is charged to the consumer on the sale of a 
taxable item or a taxable service. It is paid to the seller as an addition to the sales 
price. The seller is obligated to collect this sales tax from the customer on behalf 
of the state. The seller then remits the tax to the state tax agency (often called the 
Department of Revenue or Tax Commission) when they file their sales tax return. 
Sales and use tax returns are filed on a yearly, quarterly or monthly basis depending 
on state law and the amount of annual sales made by the business.

A use tax is a corresponding tax that applies when sales tax has not been paid on 
items that are going to be used in business. Photographers need to be aware of use 
tax because they will need to record and pay any use tax due with their returns. If 
a photographer purchased a camera from an online retailer and did not pay sales 
tax, they will likely need to pay a use tax to their state for using that camera in their 
business.

Sales tax is imposed in 45 states. New Hampshire, Oregon, Montana, Alaska, 
and Delaware do not have a state sales tax (but note that Alaska has several local 
boroughs with a sales tax). The laws governing sales and use taxes differ from state 
to state, and sometimes from city to city. This means the taxability of sales (and 
use) transactions can vary from one state to the next depending on the law.

In some states, sales tax exists at both the state and local levels, such as county, city 
and district levels. Sometimes an item that is not subject to sales tax at the state 
level may be subject to tax at the local city level. Colorado is a good example of a 
state where this type of variation in taxability rules can occur.

Sales tax is not the same as income tax! They are two separate and distinct taxes 
that are not related at all. Paying one does not offset or alleviate the obligation to 
pay the other. Income taxes are paid on the income you earn as a photographer and 
can be offset by your business expenses. This is not a sales tax. You need to think of 
the two taxes as absolutely separate. The laws for each are very different.

Services May be Subject to Sales Tax

Most of us know sales tax applies to sales of tangible items, such as an 8”x10” 
print or an album. But did you know that sales tax could also apply to photography 
services?

The number one mistake I hear from photographers is the belief that they are only 
providing a service and that services are not taxable. In many states, when the 
services photographers provide are so closely connected to the tangible property 
being delivered to the client, the photography service itself also becomes taxable.

L E G A L

But, you might say, that doesn’t make sense! 
				    It does make sense for the following reason....

Why did the clients hire a photographer? They wanted photos! If the photographer didn’t 
provide the service of taking photos, the photographer would not be able to provide the client 
with the other tangible items they are selling to the client such as a wedding album or flash 
drive of the images. If there are no photos of the wedding day, there is no wedding album. 
Due to the fact that the service is so closely intertwined with the end product, the entire 
transaction–service plus product–is taxable.

Is this the case for all states? No. Sales tax law varies from state to state, and to make it even 
more confusing, some states treat portrait photography different than wedding photography. 
This is why it is very important to know the laws in your state. You need to make sure you are 
applying the proper sales tax to the transactions that occur in your photography business.

©Kristin Korpos



L E G A L
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learn more!
C h e c k  o u t  t h i s  v i d e o .

      MYTH: Sales tax does not apply to electronically delivered images.

Many photographers believe that if you provide photography services, and only deliver digital images to 
the client electronically (no albums, prints or other items or products are sold to the client), sales tax does 
not apply to the transaction.

This is a myth, because electronically delivered images are subject to sales tax in a variety of states. 
Alabama, Maine, South Dakota, Texas, Utah, Washington and a handful of other states require that sales 
tax be charged for digital images, which are transferred electronically. Yes, you read that correctly. If you 
provide photography services along with electronically delivered digital images, the entire transaction 
may be subject to sales tax depending on state law.

And in some states, while neither photography services nor electronically delivered digital images are 
subject to sales tax, as soon as the photographer provides just one print, an album, or another touchable 
product to the client, the entire transaction becomes subject to sales tax. Say what?

I strongly recommended that photographers do not try to find ways to avoid collecting sales tax from their 
clients in the hope of “saving” their clients money or being more competitive in the marketplace. It is the 
photographer’s butt on the line when the auditors come knocking on their door. Photographers should not 
subject themselves to the risks of under-collecting their sales tax liabilities.

Collecting the proper sales tax on each of your business transactions is seriously important to the success 
of your photography business. What would you do if five years from now you discovered you owed your 
state tax agency $20,000 in unpaid sales tax liability along with penalty fees and interest? Ask yourself 
that question when you try to avoid thinking about sales tax today. I personally don’t want to be forced to 
fork over $20,000 of my profits, which should have been paid for by my clients.

In part two of this article on sales tax, which will be in the June issue, we will dig a bit deeper. We will 
address sales tax issues that arise for photographers who do business in multiple states, as well as issues 
facing photographers who provide their services to clients that may not live in the states in which they do 
business.
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LAB CORRECTED

8X10 
ONLY

$1.49

Your choice of “Lab Corrected” or 
“No Correction” at the same price.

8 wallets  1.75
4 x 6 .29
5 x 7 .99

8 x 10 1.49
10 x 10 2.49

11 x 14 3.99
16 x 20 13.50
20 x 24 19.99
20 x 30 24.99
30 x 40 49.99

LAB CORRECTED

11X14 
ONLY

$3.99

PROFESSIONAL PRINTS

Multi-image 
proof book 
pages also 
available in 
three sizes: 
8x10, 11x11, 
and 10x13.

Photos by Amelia Hill

MeridianPro keeps adding cool 
new specialty products, perfect for 
senior packages or sport and event 
promotions.

SPIRAL BOUND PROOFS SPECIALTY PRODUCTS

PHOTO 
FLIP FLOPS

DOUBLE 
SIDED 

WALLETS

iPHONE
CASES

KEYCHAINS
DOG TAGS

TICKETS
DRINKWARE

MEMORY 
MATES

TRADERS
BUTTONS

BRACELETS

Spiral bind up 
to 120 prints, 
any size up to 8x10. 
Pricing is the cost of the prints + 
$1.25 for the spiral binding. Frosted 
plastic front cover, and black back 
cover are included.

The way to sell more prints, is 
to show better proofs. Put “lab 
corrected” professional proofs in your 
clients hands, instead of just posting 
the images online.

This little mini proof book is made from 40 – 4x6 prints, then spiral bound 
for only.

$12.85

Stop worrying about how your 
images will print. Our lab corrected 
workflow is the easiest route to 
great looking prints. This is not 
computerized auto-correction, trained 
technicians view each image, making 
individual adjustments to color, 
density, and contrast.

www.meridianpro.com  |  800-544-1370

Great Prints. Great Prices. Easy Ordering. It’s that Simple.

THE BEST QUALITY OR THE BEST PRICES?

I WANT BOTH!
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Great lighting is as much about adding light as it is about subtracting it. Low-key lighting is essentially lighting that 
creates a dramatic difference between the highlights and shadows in an image, also known as chiaroscuro. Typically 
two- to three-point lighting is used, consisting of a main light, background light or accent light(s) and sometimes a fill 
light or reflector. Using multiple points of light helps create a layered quality to the lighting and adds depth to your 
image. This stye of lighting has been historically favored by master painters and is now embraced by film makers and 
photographers alike. The rapid transitions between highlight and shadow have a sculpting effect that creates volume, 
contour and drama as it falls on a subject or object.

M o d i f y i n g  &  S h a p i n g  t h e  L i g h t

Low-key lighting is all about controlling, containing, directing and shaping light so it falls exactly where you 
want it without any unintended spill onto surrounding areas in the image. To do this effectively a variety of 
light-shaping tools are employed, from simple to sophisticated.

Because I wanted a rapid fall-off of light and a specular quality for the highlights in these portraits, I choose 
a Mola Demi 22” beauty dish with no diffusion as the modifier for my key light. This lightweight and easily 
portable light shaper creates a snappy quality of light that’s perfect for a wide variety of lighting styles. If you 
haven’t checked out beauty dishes yet I encourage you to do so. I’m using a 500 WS Profoto D1 Air strobe as 
my main light. The good news is with an accessory bracket the Mola Demi can also be used with Speedlites, 
which I’ve done on other occasions as well.

To create the rim/accent light on the left and right sides of the images I used two 500 WS Profoto D1 Air 
strobes. One fitted with a standard reflector and 20º honeycomb grid attached and the other with a small 
octabank. With the D1s, grids can be attached directly to the light head; however for these portraits I used the 
older style grid that requires an intermediate reflector. I did this to create a punchier quality of light with the 
accent light. Grids are essential light-shaping tools and definitely fall into my desert island, lighting-modifier 
category. Again these are worth looking into when you can. They’re available in hard discs and fabric panels 
known as “egg crates.”

F l a g s ,  C u t t e r s ,  P a n e l s  &  V - F l a t s

In the arsenal of low-key light-shaping tools, flags, cutters, black blocking panels and v-flats are 
among the most useful and least expensive. These are tools that help direct, block and create edges 
with light. While all are available from photographic supply houses, in most cases you can easily get 
by using large 4”x8” sheets of foam core. Look for the kind with black on one side and white on the 
other. The one caveat is with using flags. In addition to being available in solid black, flags also come 
in woven fabric with varying degrees of transparency. These are known as “nets” and are used to 
reduce the light falling on an area but not entirely block it. For the portrait of Dennis in this article I 
used a net to cut down on the amount of light falling on his bare shoulder.

b y  M i c h a e l  C o r s e n t i n o

© Michael Corsentino
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T h e  E y e s  H a v e  I t

One of the first things I look for after the initial placement of my 
main or key light is the catch light. This is a highlight created by the 
main light in the subject’s eyes ideally located at between the 10 to 
2 o’clock positions in the eyes. A solid catch light is essential for 
creating eyes that look alive, contain some sparkle and have a feeling 
of curvature. I always start with my main light alone. I prefer to build 
and refine my lighting pattern one light at a time. This way I can see 
exactly what each light is contributing to the effect and exposure. 
Then after I’ve got my main light and its catch dialed in I’ll add in 
each additional light, again one at a time.

Keep in mind varying the position of your subject changes 
everything. The same, exact lighting setup was used for both of these 
portraits, but both have a very different quality of light. Only the 
position of the subject has changed. Keeping the lights in the same 
position but changing the subject position produced very different 
effects without moving one light!

P u t t i n g  I t  a l l  T o g e t h e r

Whether I’m working on location or in the studio I always try to 
shoot tethered to a computer so I can see exactly what’s being 
captured and what my lights are doing. Everything looks great on the 
back of your camera’s three-inch LCD monitor! It’s when you look at 
your images later on a much larger monitor that the things you didn’t 
see before become glaringly obvious, and most of the time extremely 
difficult or annoying to correct or recreate. This is when the extra 
effort of shooting tethered really pays off and has saved my butt more 
times than I care to admit.

A quick note on grip equipment: The heavier the lighting instruments 
and modifiers you use and the further you want to boom them in 
around your subjects, the more important robust grip equipment such 
as light stands, grip heads and boom arms become. Here I’m using 
Kupo Grip. The last thing you want is a falling light stand or creeping 
boom arm. Always, always use sandbags to protect your subjects and 
gear investment.
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F i n i s h i n g  T o u c h e s 

Since low-key lighting is all about the difference between highlights and shadows I have a few 
post-processing techniques I use in Photoshop to help accentuate the effect. To independently 
control the highlights in a low-key image I create a “levels adjustment layer” targeting only the 
highlights. This way I’m able to boost the highlights until just the right contrast between shadow 
and highlight is created. Additionally with an adjustment layer I have the use of a mask so I can 
paint the effect in or out at varying opacities as desired.

Here’s how: Highlight the Select menu in Photoshop and choose Color Range. In the Color Range 
dialog box click on the Select drop-down menu, choose Highlights from the list and click OK. 
At this point you’ll be returned to your image and all the highlights will have a marching-ants 
selection around them. Next click the Adjustment Layer icon at the bottom of the Layers Palette; it 
looks like a yin/yang symbol. Select Levels from the list of adjustment layer options and a Levels 
adjustment layer with a black mask will be added to the top position of your layers stack. In the 
Levels adjustment control panel, use the highlight slider on the right of the Levels histogram to 
control the image’s highlights. Typically I’m using this slider and sometimes the others to boost the 
highlights and create a more specular appearance. It works really well but be careful not to overdo 
it. If necessary try switching the blending mode of this layer to Softlight to soften the effect.

These low-key portraits grew out of a personal project of weekly self portraits designed to explore 
and develop new looks and skills. Try setting up your own self portrait project–it’s a great way to 
learn without pressure or the expense of models. Low-key lighting is one of the best ways I know 
to learn about lighting by isolating and seeing the effect each light has on your image. Give low-
key lighting a try and let me know you think! 

L E T ’ S  G E T  L O W

learn more!
C h e c k  o u t  t h i s  v i d e o .





THE importance OF A 

TEAM
w i t h  L a u r i n  T h i e n e s

© Salvatore Cincotta Photography



b y  L a u r i n  T h i e n e s

Every photographer has a team that surrounds them. Even if you do not realize it you have a 
team. This team could consist of actual employees and assistants that you direct on a daily basis. 
It could consist of your accountant, financial advisor or your photo lab. It could be as simple as 
your spouse or significant other–confidants who know how to push you to be better; always with 
the goal of moving you forward. The simple fact is you must have a team to function as a business 
and to help you proceed toward success.

I founded my first post-production business in the fall of 2007. With unbelievable growth and 
potential at our fingertips, it failed a short four years later. At the core of this failure was a 
dysfunctional team that did not have the right pieces in place for success. How did we get from 
having so much potential to failure in just four years? When I started the business, I did not know 
what having a solid team actually meant.

Our story was like many photographers–the jobs started coming in, growth was fast, and I 
thought, “My background is in photography; I should find someone with a business background 
to help me out.” I brought in a friend to be a partner and help with sales and marketing. We never 
truly had defined roles…red flag number one. As we grew, we added employees and layers of 
management within the organization–all without a set profile for the types of people we wanted 
as employees. What’s more, we never took the time to put together the true team of people behind 
the scenes–the bookkeeper, the accountant or real decision makers–people to tell us, “No, you 
shouldn’t do that.” What we ended up with was potential to reach for the sky, but a mismatched 
team with no real leadership, direction or defined goals. Everyone marched to a different beat, and 
the team mentality was, “Every man for himself.”

Hindsight is 20/20 and I did not know what was missing until it was too late. Our downfall was 
not that we did not work hard enough, or had a lack of ideas. We had no true, defined focus or 
leadership, myself included. And because of that we fell flat. Without going into all the details, 
our biggest downfall was not putting in place the pieces of our team that would make it really 
work well together. The dissolution of the company was not easy, and it ruined or strained many 
relationships.

I started to rebuild my team quickly with people around me who could help set us on the right 
path rebuilding a business concept with unlimited potential. Our mantra became “Laser Focus,” 
and we put together roles and responsibilities for the whole team. People who brought down 
the team mentality were let go. Ultimately, it was hard to put the team mentality above any one 
person. This team, this culture, was what had driven us to where we are today.

I M P O R T A N C E  O F  A  T E A M

© Salvatore Cincotta Photography



Our goal today for our business is to make sure the 
team we have in place is always focused on the greater 
good of the business, always pushing forward to be 
on top. We recently went through an exercise using a 
personality test (gallupstrengthscenter.com) to help us 
understand one another better. The result was nothing 
less than an “ah-ha moment.” Out of 34 defined 
personality strengths, my number-one strength was 
“Adaptability” followed by “Ideation.”

People with strong Adaptability talents live in the moment. 
They don’t see the future as a fixed destination. Instead, they 
see it as a place that they can create out of the choices they 
make right now. They discover their future one choice at a 
time. This doesn’t mean that they don’t have plans. But their 
Adaptability talents enable them to respond willingly to the 
demands of the moment, even if circumstances pull them 
away from their plans. They don’t resent sudden requests or 
unforeseen detours. They expect them. Indeed, on some level 
they may actually look forward to them. They are, at heart, 
very flexible, and they can stay productive when circumstances 
pull them in many different directions at once.

I M P O R T A N C E  O F  A  T E A M

adaptab i l i ty

ideat i o n

 These really summed up my personality in many ways 
and helped me understand that some of the mistakes I 
had made previously were in part due to how I am wired. 
Even more so, my current partner’s top two strengths–
Command and Focus.

People with strong Ideation talents are creative and appreciate 
originality. They relish free-thinking experiences such as 
brainstorming and discussion groups. They have a natural 
capacity to consider issues from multiple perspectives. They 
revel in taking the world we all know and turning it around 
so people can view it from a strangely enlightening angle. 
They think outside the box. They are fascinated by new ideas 
and concepts, which come to them easily. They love ideas 
because they can be profound, they can be novel, they can be 
clarifying, they can be contrary, and they can be bizarre. For all 
these reasons they derive a jolt of energy whenever a new idea 
occurs to them.

People with strong Command talents naturally take charge. 
They see what needs to be done, and they are willing to 
speak up. They are not frightened by confrontation; rather, 
they understand that confrontation is the first step toward 
resolution. They need things to be clear among people 
and will challenge others to be realistic and honest. Their 
talent pushes them to take risks. At times, those with strong 
Command talents may intimidate others. And while some 
may resent this talent, others often willingly hand them the 
reins. People are drawn toward those who take a stand and 
are willing to lead.

People with strong Focus talents prioritize and then take 
action. They set goals. These goals serve as their compass, 
helping them determine priorities and make alterations 
when needed to get back on course. Their Focus is powerful 
because it forces them to filter; they instinctively evaluate 
each action before taking it to determine whether it will 
help them reach their goal. In the end, strong Focus talents 
push them to be efficient. They are extremely valuable team 
members because their single-mindedness enhances the 
speed and quality of their performance and keeps the team 
on track.

c ommand
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While these traits are not polar opposites, they definitely 
work well together and play into our direct roles 
specifically. While you often have a gut feeling about 
your strengths and weaknesses, many things were put 
into perspective once these tests were taken. We were 
able to shift some points of our attention to where it 
was most effective, knowing where the strengths and 
weaknesses landed. In this case, knowledge is power.

I would recommend without an ounce of doubt, for 
anyone going into business with another, to take this 
personality test. Could you imagine a scenario where 
two leaders in the same small business have the 
Command personality trait? Two people always trying 
to best the other, talk over and confront each other? 
When building a team, knowing who your team is, and 
what each person brings to the table is invaluable. It, 
of course, is extremely impractical to have each person 
you engage with in business take the strength test. Your 
accountant, banker or camera salesman are likely not 
going to share their strengths and weaknesses with you. 
But you can look for people to surround yourself with 
who exhibit behaviors that would compliment your 
strengths. You will find that you are able to be more 
focused and efficient with your own time and, therefore, 
able to chase success that much more effectively.

Definitions trademarked and copyrighted by Gallup, Inc.

learn more!
Check out th is v ideo.

I M P O R T A N C E  O F  A  T E A M
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H I R I N G  &  T R A I N I N G  S T A F F

Last month we talked about these four steps to hiring and training staff: 
	 1. Know Your Demographic 2. Have a Relevant Interview Process
	 3. Create a Job Description 4. What Kind of Staff Member?

If you haven’t had a chance to read Part 1, definitely make your way over there as we’ll build upon 
those concepts in Part 2.

The final four steps include the methodology behind how to train staff for specific tasks, anticipating 
turnover so it doesn’t throw a wrench in your production engine and what to pay. Let’s get started!

Train Them Right
Training staff doesn’t have to be difficult or an overwhelming task. It does take time, but it doesn’t have to be wasted time. First, 
remember your staff member is not you. It would be nice if we could clone ourselves, but we can’t, and we can’t expect our staff 
to morph into our clone either, or read our thoughts for that matter. Training will take communication and time.

The key to training staff is to train them strategically so their skills build upon each other. The first thing I teach my office 
assistant or intern is how to work my collage and album-building program, LumaPix. I do this because I’m teaching them a skill 
that they’ll use to do multiple projects in the office. Next I teach them our shipping system. Again, a skill that I can have them 
use often.

Understandably, we’re photographers with photography training, not teachers with educational training, so teaching someone 
the ropes doesn’t come naturally for us. Having a Bachelor of Education degree, I learned a simple, four-step method to teach 
effectively. I have used the same process to teach my staff and many photographers around the world.

Show and Tell. 
	 Explain in detail and demonstrate the task you want to teach.

Walk Through. 
	 Guide them through the same task, allowing them to physically do it while you watch and help them along.

Observe. 
	 Watch while they do the task on their own and don’t correct them when they make mistakes. Rather, let them work 	
	 through it to the end before correcting mistakes. Ideally, they’ll start to recognize mistakes on their own.

Pass It On. 
	 Let them teach the skill to someone else. Being able to teach a skill to someone else indicates mastery of the skill.

Finally, to successfully train a staff member you want to teach them WHY you do what you do instead of just HOW you do it. 
This helps them make  good decisions on their own without having to nag you for every little thing. Dave Ramsey teaches this 
concept in his book Entreleadership and says, “Guiding values make decisions clearer.”

Ramsey suggests teaching them to understand your thinking methods. So when they have a problem, tell them to come up with 
three or more possible solutions plus a suggested course of action. Have them bring those solutions to you and discuss which you 
would pick and why. After doing this a few times, your staff member should start to see a pattern and be able to determine what 
it is you want without having to ask.

by  Vanes sa  Joy

© Vanessa Joy



H I R I N G  &  T R A I N I N G  S T A F F

Create a list of responsibilities
I first learned to create task lists while I was working 
as a marketing associate for Lawn Doctor, a 350+ 
franchise company based in New Jersey.  Task lists 
help both you and your staff member keep track of 
responsibilities and workload. A list of responsibilities 
will help maximize your staff’s efficiency and manage 
their task priorities.

Their task list should first be created by you and 
derived from the job description that you created for 
them earlier. The task list should be divided into short-
term, long-term and ongoing projects to ensure your 
staff always knows what they should do, and if things 
are slow in the short-term tasks, they have long-term 
projects to work on.

Use tools to easily assign tasks
Giving your staff new tasks shouldn’t be a chore 
or take too much time. There are many methods to 
maintain clear communication with new or ongoing 
tasks. Evernote or Google Documents allow you to 
maintain a task list that both you and your staff can 
access and change. Personally, I use my email for 
task lists, so when new tasks come in (i.e. email from 
clients asking for something), I simply forward the 
emails to the staff that I want to assign the task to. Use 
whatever works easiest for you–white boards, planners, 
Post-it notes–just be sure it’s consistent and clear.

Anticipate turnover
As we discussed in last month’s article, the job position 
you’re offering will most likely cater to a certain 
demographic depending on workload, salary and 
lifestyle. Eventually, even your best staff member will 
grow out of the demographic and be ready to move 
on. It’s just the life cycle of your job position, but it 
doesn’t have to throw you for a loop. Knowing your 
demographic will help you anticipate and be prepared 
for turnover with your current employees. If you’ve had 
someone working for you for a few years and they’re 
beginning to outgrow the job, it’s probably time to start 
finding and training their replacement. If you don’t, you 
run the risk of overpaying the existing staff member 
simply because you weren’t prepared for turnover and 
you need them to stay on until you are prepared. It’s just 
not a good position to be in for you or the staff member.

Don’t wait until the last minute to train your 
replacement. This will leave you in a rut, likely to hire 
an unsuitable replacement for time’s sake and leave you 
to train the new staff member from scratch. The only 
time you should have to train a new staff member is 
the first time you hire them for that job. After that, your 
senior staff member should participate in training his 
or her replacement or new colleague. Not only will this 
lessen the stress and time commitment on your part, but 
it also gives your new staff member multiple teachers to 
learn from. You should still supervise and participate in 
the new staff member’s training, just let the menial task 
training to be done by the senior staff member.
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What to pay?
Appropriate compensation will vary depending on where you live and what you can afford given 
your business’ income level. Do your research. Ask other professionals in your area what they 
think is fair or what they’re paying their staff members with a similar job description. This will 
help you avoid over- or under-paying your staff. Also, ask how they pay their staff members, 
(per diem, salary or hourly), taking into consideration their legal staff position (independent 
contractor vs. employee).

Keep in mind that you can also use pay as incentive for exceptional performance. Creating a 
bonus system to motivate staff members can be rewarding for everyone involved. Keep the 
bonuses (or penalties) consistent with staff performance and fair to the task and all involved.

Ultimately, no matter what or how you pay your staff, make sure they feel appreciated beyond 
monetary compensation. Taking extra time and effort to make your staff feel appreciated will 
mean a lot more to them than earning a dollar more per hour than the area average. You can do 
this in a lot of different ways like writing encouraging notes, buying them lunch on occasion (or 
making it!), or giving them a thank-you gift every now and then. Be creative, genuine and let 
your personality shine!

 Get Started!
Bogged down with work but can’t figure out what to have your staff do? Watch this video for 
my staff’s task list and how it helps my business and me. Use it for inspiration to create work for 
your staff, free up your life and improve the workflow of your business.
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For example, if you double click on the icon to the far right of the Smart Filter it will open the Blending Options for the filter.
 In here you can change the blend mode and/or opacity of the filter.

P H O T O S H O P  T E X T U R E S

It’s important to note that you’ll get a very different result by using high/
large settings in the filter and lowering the opacity than you would if you 
simply used lower settings to begin with. That’s another reason I almost 
always start with filters settings that seem too high.

Of course at any time you can see what your texture would look like with 
the blending mode applied and with lower/different filter settings. To do 
this, double click on the filter name to edit the settings. When you do, 
you’ll see the original filter without the blending options applied–you’ll 
see the full result once you click OK.

If you look at the results of the texture filter and want to lessen the effect 
in certain areas or randomize the overall effect, use the Smart Filter mask. 
Here I painted on the Smart Filter mask with a large brush set to black at 
40 percent opacity. Wherever I painted I hid the effects of the filter–but 
gradually since I painted at 40 percent opacity. You can always gradually 
show areas of the filter that you’ve hidden, by painting with white at a low 
opacity.

As is usually the case in Photoshop, there are probably five different ways to quickly and easily add an 
effect to photos, but I want to show you a couple of my favorite methods. They’re my favorite methods 
because they meet my requirements of being flexible (easily editable) and reusable.

Smart Filters

The first method is great because it doesn’t require any external images–everything is built into 
Photoshop. In order to make this work, we need to convert our Background layer to a Smart Object. 
You can do this either by going to the Filter menu and choosing Convert for Smart Filters, or by right 
clicking beside the Background in the Layers panel and choosing Convert to Smart Object. Same end 
result, just two different ways to get there.

Now from the Filter menu we’ll add a texture. Again there are plenty of interesting choices here and I’m 
not going to go through them all, but instead show you the steps and you can experiment with different 
filters. In my example I’m going to use the Texturizer filter, which as of Photoshop CS6 is found in the 
Filter Gallery. One of the suggestions I have is to overdo the filter settings at first so you can easily see 
the results, remembering that you can always back off the settings (that’s the beauty of using Smart 
Filters).

Here I chose Canvas as my texture and put the relief setting quite high, which created an effect that was 
a little much. The Smart Filter shows up in the Layers panel, and that’s what will give us some options.



To randomize the effect of the filter so it’s 
stronger in some areas and less visible in 
others, try applying the Clouds filter to the 
mask. Click once on the mask and then use 
Filter>Render>Clouds. Since this filter is 
random, you can generate other cloud patterns 
(and change the visibility of the texture filter) 
by pressing Command-F (PC: Control-F), 
the shortcut to re-apply the same filter. If you 
want to get “angrier” clouds, press Command-
Option-F (PC: Control-Alt-F). And you can 
press Command-I (PC: Control-I) to Invert the 
Mask, or use the Masks option in the Properties 
panel to Feather (blur) the clouds.
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Another option for randomizing the effects of the filter is to 
paste a photographic texture onto the mask. In order to do 
this you must view the contents of the Smart Filter mask by 
holding down Option (PC: Alt) and clicking in the mask. 
Then when you paste a copied photo it will paste into the 
mask rather than creating a new layer.

If you want to use the same Smart Filter in another photo, 
you’ll have to drag and drop the entire Smart Object onto 
another photo; you cannot drag only the filter. Then convert 
the new photo to a Smart Object and drag the copied Smart 
Filter onto the new Smart Object, and delete the copied Smart 
Object (it’s easier than it sounds).

P H O T O S H O P  T E X T U R E S



Photographic Textures

One of the best parts of using photographic textures is that you can find them anywhere–just take a walk with your 
camera and I bet in no time at all you’ll have a folder full of textures. Here’s a sampling of the many textures I have 
captured–all as Raw files by the way (more on that in a moment).

There are a few ways to add a texture photo to your project, with the hardest way being to open a texture and then drag 
it into your photo. That’s potentially the longest way since the sizing might not fit and you’ll have to scale it. I prefer to 
either drag from Mini Bridge into my document, or in Bridge select the image and use File>Place>In Photoshop. Both 
of these methods create a Smart Object that is automatically scaled to fit the document. At worst you’ll have to rotate 
the placed texture to fit the orientation of your image.

I suggest using Raw to capture all your textures so they come in as a Camera Raw Smart Object. This happens 
automatically if you use either the drag for Mini Bridge or Place options.

After dragging in or placing, the image will open in Camera Raw where you can make some initial adjustments. I 
wouldn’t worry too much about this yet as we’ll adjust it later, in the context of our photo. Click OK to add the Smart 
Object layer in your document.

P H O T O S H O P  B R U S H E S
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Once the texture layer (Camera Raw Smart 
Object) is sized, you have many options to 
blend the layers together and tweak the result:

Blend Modes & Opacity

Choose a Blend Mode in the Layers panel, or 
press Shift + to scroll through the blend modes. 
You can also lower the opacity, either alone or 
in conjunction with a Blend mode. Here’s the 
texture in Overlay mode.

Blend if Sliders

Double click to the right of the layer 
name to open the Layer Style dialog in 
the Blending Options: Custom View. Here 
you can use the Blend If sliders to make 
portions of the texture see through based 
on its lightness and darkness values, by 
moving the small triangles. In many cases 
like this example, it may work better 
by moving the sliders on the underlying 
layer. Hold down Option (PC: Alt) to split 
the triangles into two halves to create a 
smoother blend. Once you click OK you 
can come back and adjust these settings by 
double clicking again.

P H O T O S H O P  T E X T U R E S
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Note: Of course you can combine these 
options using both a Blend mode and the 
Blend If sliders. It’s possible to choose a 
Blend mode in the same dialog as you’re 
experimenting with the Blend If sliders. 
Here’s the result of changing the blend 
mode to Divide, with the previous blend 
mode applied.

Adjust in Camera Raw

At any time you can double click 
on the texture thumbnail to edit 
the Camera Raw settings. Here I 
changed Exposure, Contrast and 
Clarity in the Basic tab and added a 
Vignette in the Lens Correction tab.

When you close Camera Raw the layer will update and 
re-apply the Blend Mode and Blend If sliders. Although I 
didn’t mention this before, I would always have my origi-
nal photo as a Camera Raw Smart Object so I can edit its 
settings, just as I can edit the texture photo layer.

Apply a Layer Mask

In a process that’s about the same as we talked about with 
Smart Filters, you can further vary the effects of this photo 
layer through a mask. The only difference is the Smart Fil-
ter mask is automatically available, whereas in this case we 
have to add a Layer Mask. Once you have a Layer Mask 
you can use all the techniques mentioned before: Clouds 
filter, pasting a texture, using Properties.

Adjust in Camera Raw

This is not a typo, but a reminder that even after doing all these steps, you can, and should, continue to 
return to Camera Raw to change the settings for the texture and/or the underlying photo. For example, 
removing all the color will often dramatically affect the results of many Blend modes.

One of the best parts of using these methods is nothing is ever final. You can edit all these options: Smart 
Filter settings, Camera Raw settings, Blend Modes, Blend If Sliders, the Layer Mask and the Mask set-
tings in the Properties panel. And you can repurpose the effect onto another photo and change the results 
on the new photo.

P H O T O S H O P  T E X T U R E S
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I have taken the past several weeks to evaluate what it is that makes 
my senior business work so well. There are many elements that 
must come together in order to achieve success, but I really want to 
get your mind turning and raise your awareness. We spend so much 
time doing what will help us to simply get by. If you live with fear 
of uncertainty, you will find yourself doing the same thing year after 
year.

With an open mind, a strong will and a clean heart, anything is 
possible. If you grow to only expect one thing, it’s likely to turn 
out to be a disappointment. Now is the time photographers have to 
evolve and pay close attention to avoid complacency in our present 
marketplace. I have pulled out several small components that add 
major value to my brand and my business. Every business decision 
I make requires that I ask two questions. The first is do I believe in 
it; does it make me feel proud? The second is does it make good 
financial sense?

There have been a lot of questions lately regarding session fees. I 
live in a very economically depressed market and I am definitely on 
the high end of pricing here. If I can get the client in the door, I can 
show them the difference and easily validate pricing for my services. 
However, my senior session fee is really low in relation to the rest 
of the world. The reason for that is simple. People generally ask for 
the session price first, and if that is really high, they will probably 
not even give me a chance. It is unfortunate that price has taken the 
place of value these days with most consumers.

My goal is to get them to call. Once they call we educate them on 
what we do and how they get what they pay for. During that initial 
phone conversation, we explain everything in great detail; we 
explain our minimum order requirement and we talk about price 
ranges. This is the time that we pre-qualify each client. Offering a 
lower session fee, but maintaining my print pricing has worked well 
for me and my senior business. In my area we have clients that we 
can raise to a $2,000 order, but who may not have called if I had a 
$200 order. It is all about proper education and validation.

b y  B l a i r  P h i l l i p s
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There are many elements 
         that must come together in 
order to achieve success, 
        but I really want to get your mind turning 
                                   & raise your awareness. 
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Have you ever had a senior spend 20 minutes in the dressing room during each 
outfit change?  If they change outfits six times, that’s two hours of time you are not 
getting paid for. I never have that problem anymore. We base our sessions solely 
on time. We tell clients we have roughly two hours to photograph their session; 
that seems like a long time to a potential client. We tell them to bring tons of outfits 
and we never limit the amount of changes they can have. The reason is simple; if 
they only brought five outfits and four of them suck, my job would be much harder. 
They generally bring in a huge suitcase; therefore I have tons of choices to ensure 
my job will be easier. I tell them the faster they change outfits in the dressing room, 
the more time we will have to photograph. This motivates them to change quickly 
so we are ensured an opportunity to create a lot of variety for them.

We are encouraged to set goals from the day we are old enough to understand, 
and it is sometimes easy to set too many. This has been one of my problems over 
the past few years. I realized in order to really attain my goals I needed to set only 
three. I find it most efficient to focus on one goal at a time. It may seem like you are 
not achieving as much, but goals are met much faster when all your focus is on only 
one. You can spread your focus over all three as long as you keep it limited to only 
those three. If there are no business goals in place for your senior business that may 
truly be the missing link to your growth.

Last year one of my three goals was to work on efficiency. I wanted more time 
with my family, but wanted to make more profit. We sat down and thought of all 
the things that would have to happen in order to make that goal a reality. After days 
of analyzing, it was clear what needed to happen. I needed to photograph fewer 
seniors and somehow make more money so we put the pricing changes as well as a 
few other elements in place. I photographed 20 less seniors and made more profit. 
Choose your destination and believe that you can get there. There is nothing wrong 
with looking at the big picture, but don’t lose sight of all the elements that make up 
that picture.

Our world is getting faster paced with each year that passes. I have found it 
important to slow down when it comes to your clients. Every time I see a client 
walk through the door, I make an effort to stop what I am doing and walk up 
front to say hello. We have an office manager that normally takes care of clients 
when they come in. I think it shows a ton of appreciation if I can at least make 
an appearance to thank them for coming. If they are at the studio for a session I 
will always run up front, thank them and try to make them comfortable. Some 
studios have a really commercial feel that is not very inviting. While it is fine to be 
commercial, be sure to add that personal feel that clients may not get with any other 
business transaction they have that day. Being able to take time to sit down with 
clients and simply have conversations is one of my favorite benefits of being self 
employed. There is no need to rush and my clients are not getting that anywhere 
else. If you don’t have time to do this with your clients, it is because you are not 
making the time to do so.
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I find it most efficient
       to focus 
     on one goal at a time.



There are some things you just never like to even 
think about. There are also things that you think 
could never happen to you or your business. 
For example, we never like to think about being 
sued for any reason. This was brought to my 
attention through an experience a photographer 
friend of mine had while shooting a wedding in 
New York. Photography is generally an upbeat 
and cheerful occasion. While shooting the New 
York wedding, a lady tripped over his camera bag 
and claimed she suffered injuries. She actually 
tried suing him for a ridiculous sum of money. 
His insurance company went to work on a very 
thorough investigation and found that she has tried 
to pursue similar cases in the past. Her claim was 
found to be fraudulent and thrown out of court. 
This experience he shared was a real eye opener. 
You need to make sure you have a large blanket 
insurance policy that protects you and your 
business even when you are on location. Make 
sure you keep equipment up off the floor and keep 
a clean working environment to ensure safety. You 
may think a client would never do such a thing, 
but the world is becoming more surprising each 
and every day.

S E N I O R S
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When I opted to join the thousands of event cinematographers making the jump to HD-DSLRs 
about four years ago, they completely changed my mindset and approach in a number of key 
areas of production. Most heavily in the area of seeing light the way I need to in order to create 
stunning images with this newfound, large-format sensor. I had a whole new plethora of pixels 
to work with and I wanted my images to look crisp and sharp. I loved being able to shoot at 
high ISOs and wide apertures. The issue was I had to compensate the way I lit certain scenes to 
account for this added capability.

These days HD-DSLRs are seriously amazing in low light, especially for cinematographers 
who, other than working with film, have never had digital capabilities that allowed us to push 
so far into the ISO scale. High ISOs traditionally meant unwanted noise and artifacts. Trouble 
is, video noise is not artistic, generally speaking. It looks like bad television reception and it’s 
distracting to the viewer and awful to work with in post. But while we can push higher and 
higher into new realms of ISO cleanly, shooting at these ISOs doesn’t always mean sharp, 
highly-dimensional images. In fact, when relying on only ambient light without supplementing 
your scene with artificial continuous lighting, that’s exactly what you may get–flatly lit images 
with no depth. This is where video lights come in and it’s good to know how to use them 
effectively.

For photographers adept at using off-camera flash, these concepts will seem familiar. After all, 
we are using the same light waves in video as in still photography, although we are applying 
the basic principals in a more four-dimensional setting, time. The use of continuous lighting in 
video goes beyond lighting a single subject. It’s about having light where you want it, when the 
lens needs it. I will outline four basic video lighting techniques and products that will hopefully 
stave off any fears you may have about purchasing a continuous lighting kit that will not only 
serve your video needs, but can help with your still shooting as well.

b y  R o b  A d a m s

Many of us are already adept at this technique. You have a key light 
providing for the brightest exposure of the subject; fill light to illuminate and 
communicate the shadow areas of a shot, and there’s back light to keep our 
subjects separate from our background and add a sense of depth and dimension. 
To accomplish this during a basic interview shoot I use a set of Kino Flo Diva-
Lite 401 fluorescent lamps. 

They provide rich, white, dimmable light and include slip-on Flozier diffusers 
for maximum softness. They also generate very little heat for extended use and 
help keep my subject’s face from melting off. I like to position my key light 45 
degrees off the subject on the side opposite from where my camera will face. 
I set my camera’s exposure based on the intensity of the key light and I never 
shoot with my key light over my lens. Shooting “into” my key light keeps 
the shot dimensional and more dynamic. The fill light will bring up the focus 
exposure by filling in the shadow left by the key light. I place this lamp 45 
degrees to my camera opposite the key light. I always adjust the light’s distance 
to the subject before adjusting the light’s intensity to allow for options with 
the dimmer in case my ambient light changes while filming. See the diagram 
below to see how I accomplish professional set lighting on location.

©Vanessa Joy
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BASIC THREE-POINT LIGHTING
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For event photographers looking to do a little video shooting I’ll 
share my technique for lighting wedding receptions. The ability to 
photograph without having to use much flash will greatly enhance 
your video quality because you won’t have flash frames going off all 
the time in your video shots. If the lights are set properly, they will be 
minimally obtrusive and provide stark-enough light that you may not 
need flash at all.

I start by deciding that the person(s) giving speeches will stand on the 
dance floor or at the center of the room facing the head table. I do this 
because I want the bride and groom to be looking at the toast giver. 
I don’t want them craning their necks to look at someone standing 
behind them. You may have to coordinate with the DJ or emcee and 
the caterer to plan this in advance. It makes for more dynamic shots 
because the bride and groom will look natural while reacting to the 
speeches. It also sets the stage for great dimensional video lighting. I 
light the room using 2 ARRI 650 Tungsten Fresnels.

Why not the Diva-Lites described above? They don’t have the throw 
I’ll need to get strong, focused light across a large room and prevent 
the spill from annoying guests at their tables. Throw some barn doors 
on the lights or use some flags to control spill even more.

The ARRIs have an adjustable spot and flood position tuner to help 
me aim the light right where I want it over long distances. I place 
each light opposite each other on the same side in relation to the head 
table and the dance floor. I then place my cameras opposite the lights 
for dimensional shooting. The ARRI 650 across the room from the 
head table provides three-quarter key light for the bride and groom 
while adding rim or back light to the toast giver. The ARRI placed 
behind the head table (when room allows) gives the toast giver 
three-quarter key light while shining back/rim light on my bride and 
groom.  See diagram left.

WEDDING RECEPTION & 
            TOAST LIGHTING
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PORTABLE PORTRAIT & 
        EVENT FILL-LIGHT

There will be times when stationary studio or event lighting won’t do 
the job. After all, these lights can only cover so much ground without 
becoming ridiculously annoying. To add light to a shoot where your 
camera’s location will be changing often such as senior or family portrait 
shoots or even wedding photo sessions, consider the Frezzolini Mini-Fill. 
It gives off a warm, indoor-balanced light (up to 50 watts) and is fully 
dimmable. You can also get a dichotic filter for outdoor color balance.

You can power this light using a multitude of power sources. I use the 
Anton-Bauer Dionic Series batteries but they require an older camera 
mount sandwich adapter to allow for the power-tap connector.

I recommend using the Bescor BES015NC battery pack. Just make sure 
you purchase your Frezzolini mini-fill with a cigarette lighter adapter.

By mounting the Frezzi on a standard flash pole, you can bring this 
powerful light with you wherever you need it. I use it for photo sessions 
and cake cuttings at wedding receptions when the caterer decides to hold 
certain ceremonial events outside the range of my stationary lights. Simply 
grab it and go. There’s a nifty soft box add-on for it as well.
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When I shoot a couple’s wedding-day details, I like to add a touch of 
artificial light for dramatic effect or to even out ambient light. For small 
details and product lighting, I use the Bescor Morning Star Series LED 
light. These 5600K balanced LED lights are dimmable, run on standard 
AA batteries and two or more can be linked together to build an array of 
increasingly powerful portable lights. They each include a tungsten filter 
insert for temperature control and are perfect for ring shots and adding a 
pop of light in tight spaces. Use them off-camera for best effect. I like to 
use these lights to accent a still life from behind or up through glass-top 
tables. Mount it on a slider and have your light source move relative to 
your camera and subject...cool stuff.

When working with continuous video light it is important to make sure 
your lights are positioned for when the camera moves. Our eye does 
perceive changes in lighting as we move around within a setting, so you 
need to cover your scene with ample light. Be sure to consider where your 
subjects will move within a scene and make sure there is enough light 
hitting them to determine the mood you want to convey.  If your subject 
is stationary, simply placing your lights relative to their position may 
be enough. However, if your subjects will move around, you may need 
additional lighting to cover more than just one spot. Don’t rely on ambient 
light when shooting scenes that are scripted or may take a long time to 
shoot. The changing position of the sun will make everything look much 
different throughout the day. Try to control as much of the environment as 
possible when time permits. Event cinematographers and photographers 
can rely on portable lights to get things done quickly with fabulous results.

All equipment in this article is available at http://www.bhphotovideo.com

DETAILS & ACCENT LIGHTING

V I D E O  L I G H T I N G  1 0 1

learn more!
C h e c k  o u t  t h i s  v i d e o .

	
  
	
  

	
  

	
  
	
  
	
  

	
  

	
  
	
  

Be sure to check out our current  
Artist of the Week  

to license their tunes for only 
$19.99/song! 

	
  
	
  
	
  

Incredible	
  Playlists	
  by	
  Sal	
  Cincotta,	
  	
  
Vanessa	
  Joy,	
  and	
  many	
  many	
  more…	
  

	
  
	
  



© Salvatore Cincotta Photography A&GOT MORE QUESTIONS? 
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EDIT
FASTER
BRIDALSKINRETOUCHING
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Let’s get started by opening our image in Photo-
shop. For this action I am using Adobe Photoshop 
CS6. If you have CS5 or earlier, this specific action 
won’t work, but there is a workaround that I’ll 
explain later.

To create the action, we need to make sure our 
Actions pallet is visible. If you can’t see it open, 
or you’re not sure where it is, you can easily go 
to your Window menu at the top to make sure the 
word Actions has a check next to it.

P H O T O S H O P 
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I recently had the pleasure of being spotlighted 
in one of PhotoShelter’s webinars on their blog 
where I taught people how to create actions that 
would save time. While creating the action that 
I shared with the webinar attendees, I was able 
to fine tune a skin technique that I use in almost 
every portrait image and then automate it!

If any of you are familiar with my work, you 
know I hate skin that looks too smooth. I think 
it’s one of the first signs of bad retouching, along 
with fluorescent teeth and eye whites, the first 
things that jump out at me when I see a badly 
retouched image.

In this article, I’ll show you how to smooth 
skin without losing texture, and teach you how 
to automate this process by creating an action. 
Thanks again to Greg Gibson for letting us use 
another of his wonderful wedding portraits as an 
example image.

Once you’ve opened your Actions pallet (or confirmed 
that is open) you’re ready start. Click the new action 
icon in the Actions pallet–it looks exactly like the new 
layer icon in the Layers pallet.

I’ll name the action “Bridal Skin” and then hit 
record.

bridal skin retouching
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Critical Note: Actions do not get 
along with mouse or tablet strokes 
that are “painterly” in nature. 
Whenever possible try to avoid 
using strokes across the image, 
and try to use as many automated, 
general menu commands as 
possible.

I’ll start by dragging my 
background layer to the new layer 
icon in the bottom of the Layers 
pallet to duplicate it and then 
label it “Skin Detail.” (Since I’m 
the shortcut queen, I’ll just use 
Command J (PC: Control J.)

P H O T O S H O P
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Then I run a High Pass 
filter on this layer in order 
to isolate (and protect) 
the skin detail. To do this, 
make sure Skin Detail 
layer is selected, and then 
go to your Filter menu and 
choose Other>High Pass.

I like to then zoom my image 
to 100 percent and increase the 
radius to wherever I see the skin 
texture start to be accentuated in 
the filter. For me, it’s at a radius 
of about 10. Then I’ll hit OK.

Once you have desaturated your Skin Detail layer, 
you can change the blend mode of that layer from 
Normal to Soft Light. You can access the Blend Mode 
dropdown menu, which is in the upper left corner of 
the Layers pallet by clicking the arrows next to the 
word Normal.

Congrats! You’ve now isolated 
the skin texture. Now, onto blur-
ring the skin tone. You’ll need 
to select and duplicate the back-
ground layer again. Then label 
that layer Skin Blur.

Next, you’ll want to blur that 
layer, but let’s do it the non-
destructive way by using a smart 
filter. Select your Skin Blur layer 
and go to the Layer menu and 
choose Smart Objects Convert to 
Smart Object. A small box will 
appear on the thumbnail of your 
Skin Blur layer. 

Make sure you drag the saturation value 
all the way down to -100 and then press OK. 

6

8

If I just leave this Skin Detail layer as 
it is, I’ll start to see some crazy color 
variations appear in the highly contrast-
ed areas once I change the blend mode 
to something else (which we will do 
next). First, we need to make sure we 
desaturate the layer. So with the Skin 
Detail layer selected, go to your Im-
age menu and choose Adjustments, and 
then Hue/Saturation. Again, for those 
of us who are patience challenged, you 
can press Command U (PC: Control U).

9
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Most of the older actions would stop 
there, but here’s where the power of 
Photoshop CS6 really shines: I want 
to create a mask on the Bridal Skin 
group so the effects of the layers 
are only shown where there is skin 
tone in the image, so I will select the 
background layer then go up to the 
Select menu and choose Select>Color 
Range.

After you’ve converted your 
layer to a smart object, you 
can now apply a blurring filter 
nondestructively! So let’s go 
to the Filter menu and choose 
Blur>Surface blur. Since I isolated 
the skin texture earlier, I can focus 
on blurring the skin to get a nice 
even tone throughout the face. And 
the nice thing is, if I go too far 
with the blur, I can always come 
back later and edit the amount of 
blur I originally applied since it is 
a smart filter! I’ll use a Radius of 
30 and a Threshold of 20, and then 
press OK.

P H O T O S H O P
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Once the processing finishes, find an opacity 
for that skin blur layer that looks nice and 
natural. For my image, it’s about 50 percent.

Here’s where things get interesting. In the 
bottom of your Layers pallet there’s a little 
icon that looks like a file folder. Click on 
that to create a new group. Double click the 
group where it says Group 1 and name it 
“Bridal Skin.”

It’s important that you follow this section 
very carefully. Select the Skin Detail layer, 
and drag and drop it on the new group that 
you just created called Bridal Skin. Once the 
Skin Detail layer is in the new group, only 
then should you select the Skin Blur layer 
and drag and then drop it into the Bridal 
Skin group.

The reason for this is that the Skin Detail layer must 
rest above the Skin Blur layer in the Layers pallet for 
the skin detail to show. (If this doesn’t happen on its 
own, and you see that the Skin Blur layer is resting 
above the Skin Detail layer, you can select the Skin 
Detail layer and instead of dragging and dropping 
it into its proper order in the group, select the layer 
itself and then press Command ] (PC: Control ]) to 
correct the order of the layers in the group. This is 
what your Layer pallet should look like:

Once I’m in the Color Range dialogue 
box, I can choose Skin Tones from 
the select dropdown menu. Then I 
will check the Detect Faces box, use a 
fuzziness of 30 and press OK.

CS5 Note: If you’re using CS5, here’s 
where your action will deviate: Skin 
Tones isn’t an option in CS5, so you’ll 
need to select Highlights instead.

You’ll see the marching ants appear and they 
should be selecting a good portion of the skin 
tones in your image. Then select the Bridal Skin 
Group layer in your Layers pallet and click the 
mask button in the bottom of the Layers pallet.

This is what your mask will look like. You can preview your 
mask by clicking on your mask icon in the Layers pallet while 
holding down your Option or Alt key.
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Remember, this needs to be an average for most of 
your work, since we are creating an action. You can 
always come back and change that value later if you 
are running it on an image where your client has 
much lighter or much darker skin.

NOW you can press the Stop button in the bottom of 
the Actions pallet to stop the action from recording.

Voila! Your action has been created! Now you can run this on 
any portrait of a bride that you’d like. You can even create two or 
three different versions. For example, you could create one light-
smoothing, one medium-smoothing and one high-smoothing action 
depending on how much of the effect you want to see. Also, if you 
think you have lost too much detail in the skin, you can always du-
plicate the Skin Detail layer, ultimately doubling the effect. Or you 
can decrease the opacity if the Skin Blur layer even more.

Here’s a zoomed-in image showing the before and after of what this 
action was able to achieve on this image. Not bad what you’ll be 
able to get from one click of the mouse! Enjoy!

One last step when doing skin smoothing work is to make sure the 
blur that I applied to the layer called Skin Blur doesn’t apply to 
areas of the face that are darker, like shadow areas (for example, 
the crease where the bottom of her nose meets the skin above her 
upper lip).

So for my last step, I will double click the Skin Blur layer, which 
will reveal the Layer Style dialogue box, and I will pull the black 
triangle underneath the words “This Layer” from 0 to 50. If the 
majority of your clients have darker skin tones, you might choose 
to keep this a little bit lower than 50; maybe 30. You can find this 
in the Blend If box in the bottom of the dialogue box, and then 
press OK.
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b y  S k i p  C o h e n

It might well be the most important ingredient of a good blog. You need to understand your own 
motivation. You need to have a plan. So many photographers start their blog because they just want 
to throw their opinions out there. They think a blog allows them to be heard. Well, while that’s 
partially true, every opinion has to be relevant to the audience you’re trying to attract.

B L O G G I N G

Let’s clarify the title of this month’s article. “It” doesn’t 
all start with a blog, because if you haven’t learned the 
ingredients to the craft then no blog in the world is going 
to help your marketing efforts or build your business.

So, I’m assuming you’re doing a few things, starting with 
everything you can do to be the very best photographer 
on planet earth! Can you get by being only average? Of 
course you can, but why would you want to?

Second, I’m assuming you’re paying attention to 
developing a marketing plan. The thing is, anybody can 
land their first customer. The challenge is getting that first 
one to come back and then land the second, third 
and fourth.

Now let’s talk about a blog. The big difference between 
your blog and your website is simple. Your site is where 
you sell your services and products–your blog is where 
you open up your heart. A really good blog is all about 
giving back, sharing and helping other people.

When I started to get into social media and my blog 
four years ago I was told by a few members of my own 
family I was too old for this stuff. I was too old to be on 
Facebook and Twitter. Well, like so many challenges in 
my life, my most favorite quote of all time applies:

“I do it because I can. I can because I want to. I want to 
because you said I couldn’t!”

And here I am, now on my third blog and all along the 
way, every day has been a learning experience. So, let’s 
take what I’ve learned and observed and get you on the 
right track.

Consistency is one of the most important ingredients in having a successful 
blog. My definition of “successful” is drawing the traffic you’d like to have 
and the right audience. My suggestion for photographers is to blog no less than 
twice a week, and make it the same two days every week. If you can do more, 
go for it, but two days a week is the minimum.

 +What do you want to accomplish? 

    +How often do you intend to post?

Stay on point! Don’t get caught up in irrelevant topics and remember your audience. I’ve seen a 
lot of posts that hit on issues that are personal to the author and have absolutely no relevance to the 
readership.

Here’s a prime example: A young woman wanting to be a family and children’s photographer did a 
post about her drunken binge over the weekend with her girlfriends at a local bar when their favorite 
band was in town. While it was hysterical to read, it was more appropriate for a college crowd than 
mothers wanting to hire a photographer for a family portrait.

+What’s your topic and who’s your target?

It’s okay to put your opinions out there, but if you’re not an expert then don’t 
tread in water too deep. A great blog can help build your reputation, but being 
weak in a topic you claim is your area of expertise is BS also known as “brand-
ing suicide!”

+Are you an expert on the subject?

Ed Foreman, a terrific marketing and motivational consultant from Texas spoke to a group of us at 
Polaroid years ago. He put out a line that’s stayed with me all these years,
“If I can see the world through my client’s eyes, then I can sell my client what my client buys!”

+Know Your Audience!



Now modify that for your blog:

“If I can see the world through my reader’s eyes, then I can 
sell my client what my readership buys!”

You’ve got to see the world through their eyes and understand 
their challenges, what they’re most interested in reading about 
and where they need the most help.

+The 4 Basic Ingredients 
                        for Success:

Have great content

Be easily understood

Work to build loyalty

Allow comments

Of the four, to me, being easily understood is the most 
important. Be concise with short sentences and stay on 
topic with each theme. Remember to proofread your work, 
because mistakes in spelling and grammar only challenge 
your credibility. And stay away from Tweet lingo and ab-
breviations. Just remember your overall goal is to build blog 
loyalty and interest.

There’s so much I could write about on just this one topic, 
but let’s hit on a couple of direct questions that come up all 
the time.
 

+When is it most effective to post?

I’ve repeatedly Googled this question and have found every 
possible answer. First I found an expert who said Tuesdays and 
Wednesdays between 9:30 and 11:00 EST. Another one said 
Thursdays and Fridays between 2:00 and 4:00 EST. Well, ev-
erybody has an opinion and here are the only things I could see 
people agreeing on.

It depends on your target audience, and Mondays, Fridays, 
Saturdays and Sundays are typically lower traffic days on blogs. 
Lastly, post in the morning and tweet in the afternoon.

+How long should a blog post be?

In general 200–1,500 words, but the high end is very sensitive 
to the strength of the topic. People are looking for short, concise 
and high-impact posts to read. While I’ve gotten away with long 
posts, in general they only get the traffic if it’s a really helpful 
series of concepts or a hot topic. People are willing to invest a lot 
of time in a blog post if there’s a lot of helpful content, otherwise 
they’ll read a paragraph or two and move on.

+How do I reduce bounce rates?

Bounce rates, for anyone who doesn’t understand them, are 
simply people who weren’t on your blog or site long enough to 
pay attention to anything. They walked into the “store” looking 
for one thing and decided it was time to leave within seconds and 
just turned around and walked out.

Want to lower your bounce rate? First, deliver what you prom-
ised. Give your blogs some zip. Make your blog look good and 
always try to include a supportive image or illustration. Limit the 
number of links you have to ads and make following your blog 
an experience.

B L O G G I N G

“A really good blog is all about

giving back
       sharing &
helping other people.”



Last on the list is a quote from a Seth Godin 
video I watched a while back:

“Life is too short to do something you’re not 
passionate about!”

A really good blog is all about passion. It takes 
time, dedication and work. It’s no different than 
your images. A blog allows you to open up and 
share your heart with your readers. It’s about 
your personality and how you see 
the world. Be yourself, but be the best 
you can be.

My buddy, Levi Sim, has a great line, “Act as if 
your grandmother’s watching you!” Well, I’m 
modifying that statement:

“Write as if your grandmother is reading every-
thing you write!”

B L O G G I N G

PHOTOGRAPHERS
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Less Time and Get More Attendees!

Subscribe to Stay Connected to Events for FREE
Go to FisheyeConnect.com

“Life is too short 

to do something 

you’re not 

  passionate          	
				    about!”
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SELLING in a

DIGITAL 
WORLD

w i t h  K r i s t y  D i c k e r s o n



One question I think every photographer gets asked by clients 
is, “Do I get the disk of images?” I know this is a highly 
debated topic. There are photographers who give away their 
images and there are photographers who charge a premium for 
their services and still don’t have to “sell” that they will give 
the images to the consumer.

Photographers who started their photography careers with film 
seem to have a harder time with this concept, and understandably 
so. Clients prior to the digital revolution would charge a 
commission for the session, but the bulk of sales would be on the 
back end with print orders. Now, clients demand digital images, 
and prints are hard to sell for most photographers. Photographers 
have to evolve to meet consumer demands, but on the other hand 
it has become harder for photographers to be profitable.

What is my philosophy 
			    & what can I do?
Every client of mine will have a copy their images, not full 
resolution but high. I have three collections and the top two 
include a copy of the images. The bottom collection I typically 
use as a bargaining tool. I never come down in price. I think the 
minute a photographer comes down in price it devalues them 
and their service. What if I walked into Louis Vuitton and told 
them my disposable income is lower this month. Do you think 
they would say, “Okay we will sell you this bag for less?” They 
won’t! If they did, the value of LV bags would decline. It is the 
same for offering our service. Never discount. You can offer a 
gift voucher but discounts will kill your brand. 

b y  K r i s t y  D i c k e r s o n
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One question I think every photographer 
gets asked by clients is,

  “Do I get the disk of images?”



Why do I sell clients their digital images? I understand 
from the consumer’s perspective the importance of 
having the digital images. I have young kids and from 
a personal perspective, I want a copy of any images of 
my family. Notice also that I said “sell” them images, 
not “give” them images. Here is where a huge mistake 
for a lot of photographers occurs; their prices are not 
high enough. Before the digital revolution, sales would 
come on the back end. Now the sale is on the front 
end. Photographers need to know their fixed monthly 
expense and variable expenses. I have said it before and 
I will say it again. To run a photography business you 
have to be a business owner first and a photographer 
second. Once you know your expenses you can 
properly price yourself to make a profit. You have to 
work backwards to figure out your cost rather than just 
setting a price hoping to attract buyers.

So we have established that selling the digital images 
should be an option. For the record this is not right for 
every photographer and business model, but in general, 
with technology changes this is where business has 
forced us to evolve.

 Why do I sell clients their digital images?
I understand from the consumer’s perspective 
           the importance of having the digital images.

S E L L I N G  D I G I T A L  F I L E S
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So we have established that selling the digital images should be an option. For the record this is not right for every 
photographer and business model, but in general, with technology changes this is where business has forced us to 
evolve.

This leads us to the next question, how do I get the images to the client? 
           You have four options:

The original disk. The pro is that they actually get a physical item. You can add branding 
and packaging and most users know exactly what to do with a disk. But the cons are the 
durability and reliability of the disk. Since it is a product you are selling you will have to 
charge and remit sales tax in most states. The cost of a branded disk is around $25 and 
after shipping you are probably looking at $30. The biggest con with disks is that they are 
going away and will continue to do so. Computers are being made with no disk drive and 
the majority of software is now apps or downloads eliminating the need for a disk. I think 
the disk drive will eventually go the way of the floppy drive. Does anyone remember a 
floppy drive?

Flash drive is another option. Flash drives are pretty inexpensive, but if you go the 
branded route you are looking at about 20–30 per drive depending on the quantity you 
order and the finished material. I don’t see flash drives going away anywhere in the near 
future but typically if you go the branded route you are looking at $700 to $1,000 out of 
pocket upfront. 

You can use a service like Dropbox. There are many cloud service providers where you 
can pay a yearly fee to store files in a folder in their cloud. Personally, I use Dropbox for 
all my documents and organization. You drop the images in your Dropbox and then share 
the folder. The cost is relatively inexpensive. The only con is there is no experience that 
goes with that delivery method.

An option that is rather new, and I am currently using is PASS, which is a cloud-based 
gallery like Dropbox, but it is built for photographers. Which means it is branded and 
they are working on updates to gear it more toward photographers. Images can be 
uploaded to the cloud and will be out there for 30 days for free. You can pay a fee to 
have them published for a year for $29. You can track the views and they are working 
on giving clients the ability to make print orders. They have an iPhone/iPad app so 
clients can have their galleries at their fingertips wherever they are. There is a Facebook 
share option as well, so when they share your branding will go with those images. You 
only pay a fee when you actually need a gallery and just did a job–in others words it is 
better for cash flow.
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There are many other companies that offer services for proofing and digital 
delivery. Some do both and some do one or the other. I know this is a highly 
debated topic on the rights of digital images and I know a lot of people will 
disagree with me. The bottom line is our industry is evolving like every other 
industry. You have to be open to change and constantly looking for providers 
that solve the needs of your business. I am sure there are other delivery 
methods but everyone’s needs are unique. You can look at your services and 
expenses, and decide what works best for your business model. Never stop 
learning!

Does all this mean you can’t sell images? Absolutely not! In order to maximize 
print sales here are a few suggestions that I need to do more often myself:

Meet in person. Schedule a gallery revealing or just schedule a meeting right 
when they get back from the honeymoon. Use this time to show them their 
images, which brings me to my next point….

Display images. They won’t buy what they can’t see. Have impact images 
that make a statement displayed to show clients what can be done with your 
images. Make sure to have display albums as well!

Go big or go home. Make sure the images you have on display are big! 
Again they will buy what they can see.

I try to have a couple ideas for gallery wraps or designs ready to show. You can 
do this in Photoshop. They are visual and you need to show them. 

For that day only offer them 20 percent off. This is when they are excited 
about the images and emotionally connected. Anything that is ordered that day 
gets a discount.

Have an example of a 16”x20” from your lab and show them an example of a 
16”x20” from a local non-professional lab. When they ask, “Why can’t I just 
print these at the local Wal-Mart?” This is what you turn to…gets them every 
time.

Our industry is evolving. If we can raise the standards across the board and 
educate clients I believe our industry as a whole can continue to stay alive. So 
many people say in five years professional photography will be almost gone. 
I highly disagree but in order to survive you have to operate as a business and 
raise standards.

Let me end on this note–learn, absorb and then apply advice to your business. I 
am not saying digital delivery is right for all photography businesses; it is just 
what works for me.

© Kristy Dickerson
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Our industry is evolving. 

     If we can raise the standards 
           across the board 
                           & educate clients 
I believe our industry as a whole 
                  can continue to stay alive.
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L O C A T I O N :  O’Fallon, IL

P A S S I O N :  Weddings & Seniors

Sal was exposed to photography at a very early age and has been 
in love with our craft ever since. He can still recall the smell of the 
chemicals in his aunt’s makeshift dark room in the basement. However, 
a career in photography would elude him for over 20 years. 

Graduating from one of the top 25 business schools in the country, Sal 
pursued a corporate career with his photography becoming more of 
a hobby. In 2007, he left corporate to pursue his dream of a career in 
photography and has never looked back. 

Today, Sal Cincotta and his wife Taylor own and operate a very 
successful studio in the St. Louis metro area. Salvatore Cincotta 
Photography, Salvatore Cincotta Films, and BehindtheShutter.com.

Focused on wedding and senior portraiture, Sal has had the 
opportunity to shoot for corporate clients like Nordstrom’s and the 
St. Louis Cardinals to elite sports celebrities and the White House, 
photographing President Obama. 

F E A T U R E D  A R T I C L E S

Q&A with Sal Cincotta

+

E D I T O R
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L O C A T I O N :  Freehold, New Jersey

P A S S I O N :  Weddings

“Wedding films are my life.  It’s all about the the story-telling. The art of 
seeing action, drama and beauty unfold and then harnessing the emotion 
of it all and the making it come to life on screen...that’s why I do this.”

Rob Adams began his video career in television over 15 years ago. Four 
years after that he merged into the wedding industry and eventually 
started his own business in 2006. Recently, Rob filmed and directed 
his first full-length feature film that was premiered at Robert DeNiro’s 
personal screening room in New York City.

Because Rob is on the cutting edge of the DSLR video revolution, his 
business has grown rapidly over the past few years and his passion 
for finding new creative ventures in the field has as well. His main 
goal, along with making sure that every product that leaves his studio 
is amazing, is to teach other wedding film-makers how to bring their 
work to the next level.  Speaking around the world at venues such as 
creativeLIVE, WPPI, Imaging USA and more, he wants to see each 
and every film-maker learn about the little things that make filming and 
editing go from “good” to “the best in your market.”

F E A T U R E D  A R T I C L E S
Video Lighting 101

R O B
A D A M S +
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L O C A T I O N :  Sarasota, Florida

Skip Cohen is President/Founder of Marketing Essentials International, a 
marketing consulting firm specializing in projects dedicated to photography, 
primarily photographic education. (www.mei500.com)   

He is also the founder of Skip’s Summer School (www.mei500.com),  the 
founder of the Akron Photo Series (www.AkronPhotoSeries.com ),  and 
the co-founder of GhostRighters (www.GhostRighters.com), a content 
resource for professional photographers needing help with editorial content, 
web re-design and marketing.  His blogs, SkipsPhotoNetwork.com and 
PhotoResourceHub.com, are read by thousands of professional and aspiring 
photographers. On May 21, MEI launched PhotoResourceHub.com a new 
content site for professional photographers with video, podcasts, blog posts 
and an ongoing calendar of industry events.

He has been a recipient of ADL’s Torch of Liberty Award and Foto Imagen 
Magazine’s Man of the Year Award and in 2001 he received PPA’s Legacy 
Award for his work in support of PPA Charities. His images have been 
published in a long list of photographic trade magazines, including: 
Rangefinder, Shutterbug, Foto Imagen, Studio Photography and Design, 
Petersen’s Photographic and The Hasselblad Forum. He’s also competed in 
print completion in both WPPI and PPA’s national conventions. 

In addition, he has written six books on photography: “The Art of Wedding 
Photography”, “The Art of the Digital Wedding” and “The Art of People 
Photography” with Bambi Cantrell: Don Blair’s “Guide to Posing and 
Lighting Body Parts” and “Wedding Photography from the Heart”, 
co-authored with celebrity wedding photographer Joe Buissink.  Book 
number six, “GoingPro”, co-authored with Scott Bourne, was released by 
Random House in October 2011 and remains on the photography book best 
seller list at Amazon.

F E A T U R E D  A R T I C L E S

It All Starts With a Blog
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L O C A T I O N :  Petaluma, California

P A S S I O N :  Lifestyle Photography

Michael Corsentino is an award-winning, contemporary 
wedding and portrait photographer. He is an American 
Photo 2013 Top 10 Wedding Photographers nominee, 
Adobe Photoshop and Adobe Lightroom expert, Capture 
One Pro Certified Professional, author, contributing writer 
for Photoshop User Magazine, Shutter Magazine and 
Resource Magazine, speaker and international workshop 
leader.
 
Based in Northern California, Michael has been shooting 
digitally since 1999. His love affair with the magic 
and science of photography is more passionate today 
than ever. Stylish, dramatic, edgy and modern images 
set Michael’s photography apart. His award-winning 
photojournalism, fashion and editorial styles have made 
him an in-demand portrait and destination-wedding 
photographer. Passionate about education, Michael loves 
to share his lighting and posing secrets, post-processing 
techniques, time-saving workflow strategies and shooting 
philosophy at workshops and speaking engagements.
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L O C A T I O N :  Tampa, Florida

P A S S I O N :  Photoshop

Dave Cross has been helping photographers and 
creative professionals get the most out of Adobe 
software for over 25 years. He has a Bachelor of 
Education, is an Adobe Certified Instructor, and is 
a Certified Technical Trainer. Dave has taught at 
Photoshop World, the Texas School of Photography, 
the Santa Fe Workshops, and Imaging USA. He 
runs the Dave Cross Workshops in his own studio/
workshop in Tampa, Fla. He is well-known for his 
engaging style, humor and ability to make complex 
topics easy to understand. In 2009 Dave was 
inducted into the Photoshop Hall of Fame.

F E A T U R E D  A R T I C L E S
Adding Texture to Your Photos
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L O C A T I O N :  Atlanta, Georgia

P A S S I O N :  Weddings & Engagements

Kristy Dickerson is the founder and CEO of Fisheye 
Connect (www.fisheyeconnect.com), professional 
laundry sorter, CFO of multitasking, wedding 
photographer, mom of two, and a wife who is 
never wrong… never. Upon earning her degree in 
finance and business management, she started her 
photography business after the birth her first son. 
As if she didn’t already have enough on her plate, 
in June 2010, Kristy launched Fisheye Connect 
for other photographers, like herself, looking for 
quality education. Fisheye Connect allows aspiring 
photographers to connect with photography industry 
experts by location, instructor or interest. It is a 
searchable database for photography workshops/
events, along with services that help instructors 
manage the marketing and financial aspects of their 
businesses. Merging Kristy’s business sense with 
her passion, Fisheye Connect has become a thriving 
community of photographers learning and growing 
together. 

F E A T U R E D  A R T I C L E S
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J O Y+
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L O C A T I O N :  Freehold, New Jersey

P A S S I O N :  Weddings 

14 Years of photography, eight years of shooting weddings, three years of 
business ownership (not to mention five college degrees)

Vanessa is a trilingual (English, Spanish and a bit of French), award-winning 
photographer, living with her husband, Rob Adams, in the great state of New 
Jersey. She has studied photography since 1998 and has spent most of her life 
running a successful wedding photography studio that shoots 35 weddings 
a year (at a premium price). In her first three years of business, Vanessa 
achieved honors such as: 20+ publications in print magazines (including 
three cover photos and interviews in PDN and Rangefinder), a Grand 
Imaging Award from PPA and a second-place wedding Image Award from 
WPPI.

Vanessa enjoys speaking across the country at venues such as CreativeLIVE, 
Clickin Moms, WPPI, Imaging USA, PPA-related conventions and personal 
workshops. She is recognized for her talent and even more for her business 
sense. Vanessa’s clients love working with her, and industry peers enjoy 
learning from her generous, informative and open-book style of teaching.

F E A T U R E D  A R T I C L E S
Hiring and Training Staff Pt 2
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L O C A T I O N : Boston, MA

P A S S I O N : Business

Kristin Korpos is the founder of Nifty Knowledge Rocks, which provides 
business, legal and tax information to photographers. She is an attorney 
licensed to practice in New Jersey, and holds a Masters in Business 
Administration as well as a Masters in Accounting.

In 2009, while trying to find a creative balance to her corporate career, 
Kristin started a photography business in the Boston area 
(www.kristinkorpos.com). She quickly became a much sought-after 
wedding photographer whose work has most recently been featured in 
Rangefinder. 

With the success of her own photography business, Kristin has become 
passionate about empowering other photogpreneurs with the knowledge 
necessary to run healthy, legitimate, successful businesses. Through the 
NKR podcast, videos, and blog, photographers can gain knowledge on 
a variety of topics. Other resources, including contracts, legal forms and 
sales tax guides are available in the Nifty Knowledge Rocks Shop 
(www.niftyknowledgerocksshop.com).

F E A T U R E D  A R T I C L E

Sales Tax
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L O C A T I O N :  Landis, North Carolina

P A S S I O N :
Seniors, Babies, Families & Weddings

Blair’s team includes four employees plus Blair, 
who photographs 20 to 30 weddings and 500 studio 
sessions per year. Blair has a passion to teach 
photographers how to express themselves in ways 
they can’t find with traditional training. He speaks to 
and teaches thousands of photographers and digital 
artists each year at national conventions and expos 
including WPPI, Imaging USA, SYNC Seniors, and 
various PPA conventions.

Blair and Suzanne’s “eclectic elegance” style and 
positive energy educate and inspire photographers, 
while allowing them to stay true to themselves. This 
young team pushes the envelope daily with creativity 
and positive inspiration. As a side note, after 10 
years of marriage, Blair and Suzanne welcomed Ava 
Blair Phillips into the world on August 3, 2011.

F E A T U R E D  A R T I C L E

Time For a Checkup
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L O C A T I O N : North Bethesda

P A S S I O N :
Photoshop

Great photo retouchers are ghost artists. The viewer rarely has 
any idea of the amount of work that goes into making the final 
picture after the photographer has clicked the shutter. And that is 
the way it’s supposed to be.

Kristina studied digital art and photography at Elon University in 
North Carolina and then interned for D.C.-based photographer, 
John Harrington, where she learned the business behind the art. 
Since she was a photographer before she started retouching nine 
years ago, she understands her role as a retoucher, as well as 
the aim and vision of the photographers. In other words, “she 
speaks camera,” and makes certain always to stay within their 
photography style. Her clients hail from all over the world and 
include National Public Radio, Sports Illustrated, Time, Inc., 
XM Satellite Radio, onOne Software, Cotton Inc. and 
Hasselblad USA. 

F E A T U R E D  A R T I C L E

Edit Faster-Bridal Skin Retouching
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L O C A T I O N :  Portland, Oregon

P A S S I O N :
Weddings & Engagements

Laurin Thienes was 17 when he photographed his first 
wedding – 20 rolls of Porta400VC. Never looking 
back he went on to study photography with some of 
the most well-known photography studios in Oregon 
as well as leaving the state to study still photography at 
Brooks Institute in Santa Barbara, CA. Upon returning 
to Portland, Laurin was the studio manager of Holland 
Studios, a high-end, high volume wedding photography 
studio photographing over 250 weddings per year. After 
his departure from Holland Studios, he has continued to 
work as a contract and freelance photographer, having 
work published in Grace Ormond, Men’s Style, and 
Rangefinder. Most recently, Laurin is the co-founder of 
Evolve, a premier wedding and portrait post-production 
service in Portland, OR. Outside of photography, Laurin 
also likes to cook, travel, and spend time with his wife 
and young daughter.

F E A T U R E D  A R T I C L E

The Importance of a Team
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FOLLOW US !
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